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1   Preface

Thank you for purchasing the Analog Devices, Inc. ADSP-CM419F EZ-KIT ® evaluation system.

The ADSP-CM419F processor is based on the ARM® Cortex®-M4 prprocessor core with floatingpoint unit operat-
ing at frequencies up to 240 MHz, and the ARM® Cortex-M0TM processor core operating at frequencies up to
100 MHz. The processors integrate up to 160K Bytes of SRAM memory with ECC, up to 1M Byte of flash memo-
ry with ECC, accelerators and peripherals optimized for motor control and photo-voltaic (PV) inverter control, and
an analog front end consisting of up to two 6 times simultaneous sampling 16-bit SAR-type ADCs, one 14-bit SAR
monitor ADC and one 12-bit DAC. The EZ-KIT ships with all of the necessary hardware to get you up and run-
ning and start the evaluation immediately.

The EZ-KIT contains an analog interface and PWM/digital interface. These interfaces are provided for connecting
with daughter boards to expand on the functionality of the EZ-KIT.

The evaluation board is designed to be used in conjunction with the IAR Embedded Workbench®and Segger®

development environment for advanced application code development and debug such as:

• Create, compile, assemble, and link application programs written in C++, C, and assembly

• Load, run, step, halt, and set breakpoints in application programs

• Read and write data and program memory

• Read and write core and peripheral registers

Purpose of This Manual
This manual provides instructions for installing the product hardware (board). The text describes operation and
configuration of the board components and provides guidelines for running code on the board.

Intended Audience
The primary audience for this manual is a programmer who is familiar with an ARM Cortex-M4 core. The ADSP-
CM41x family of mixed-signal control processors is based on the ARM Cortex-M4 core.

Preface
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For additional information about the Analog Devices processor, see the Hardware Reference Manual. The document
describes the core and memory architecture of the ADSP-CM41x processor, but does not provide detailed
programming information for the ARM core.

The applicable documentation for programming the ARM Cortex-M4 core includes:

• Cortex-M4 Devices Generic User Guide

• CoreSight ETM-M4 Technical Reference Manual

• Cortex-M4 Technical Reference Manual

For more information about programming the ARM core, visit the ARM Information Center:

http://infocenter.arm.com/help/.

Manual Contents
The manual consists of:

• Using the board

Provides basic board information.

• Hardware Reference

Provides information about the hardware aspects of the board.

• Bill of Matrials

A companion file in PDF format that lists all of the components used on the board is available in the installa-
tion directory for the Board Support Package (BSP) and on http://www.analog.com/ADSPCM419FEZKIT .

• Schematic

A companion file in PDF format documenting all of the circuits used on the board is available in the installa-
tion directory for the Board Support Package (BSP) and on http://www.analog.com/ADSPCM419FEZKIT .

Technical Support
You can reach Analog Devices processors and DSP technical support in the following way

• Post your questions in the processors and DSP support community at EngineerZone®:

http://ez.analog.com/community/dsp

• Submit your questions to technical support directly at:

http://www.analog.com/support

• E-mail your questions about processors, DSPs, and tools development software from CrossCore Embedded Stu-
dio or VisualDSP++®:

Manual Contents
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If using CrossCore Embeded Studio or VisualDSP++ choose Help > Email Support. This creates an e-mail to
processor.tools.support@analog.com and automatically attaches your CrossCore Embedded Studio or Visu-
alDSP++ version information and license.dat file.

• E-mail your questions about processors and processor applications to:

processor.tools.support@analog.com

processor.china@analog.com

• Contact your Analog Devices sales office or authorized distributor. Locate one at:

http://www.analog.com/adi-sales

• Send questions by mail to:

Analog Devices, Inc.

One Technology Way

P.O. Box 9106

Norwood, MA 02062-9106

USA

Supported Processors
This evaluation system supports the Analog Devices ADSP-CM419Fprocessor.

Supported Tools
Information about code development tools for the ADSP-CM419F EZ-KIT ® and ADSP-CM41x family of process-
ors is available at:

http://www.analog.com/ADSPCM419FEZKIT

Product Information
Product information can be obtained from the Analog Devices Website

Analog Devices Website

The Analog Devices website, http://www.analog.com, provides information about a broad range of products - ana-
log integrated circuits, amplifiers, converters, and digital signal processors.

To access a complete technical library for each processor family, go to http://www.analog.com/processors/techni-
cal_library. The manuals selection opens a list of current manuals related to the product as well as a link to the
previous revisions of the manuals. When locating your manual title, note a possible errata check mark next to the
title that leads to the current correction report against the manual.

Supported Processors
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Also note, MyAnalog.com is a free feature of the Analog Devices website that allows customization of a web page to
display only the latest information about products you are interested in. You can choose to receive weekly e-mail
notifications containing updates to the web pages that meet your interests, including documentation errata against
all manuals. MyAnalog.com provides access to books, application notes, data sheets, code examples, and more.

Visit MyAnalog.com to sign up. If you are a registered user, just log on. Your user name is your e-mail address.

EngineerZone

EngineerZone is a technical support forum from Analog Devices, Inc. It allows you direct access to ADI technical
support engineers. You can search FAQs and technical information to get quick answers to your embedded process-
ing and DSP design questions.

Use EngineerZone to connect with other DSP developers who face similar design challenges. You can also use this
open forum to share knowledge and collaborate with the ADI support team and your peers. Visit http://
ez.analog.com to sign up.

Notation Conventions
Text conventions used in this manual are identified and described as follows. Additional conventions, which apply
only to specific chapters, may appear throughout this document.

Example Description

File > Close Titles in bold style indicate the location of an item within the CrossCore Embed-
ded Studio IDE’s menu system (for example, the Close command appears on the
File menu).

{this | that} Alternative required items in syntax descriptions appear within curly brackets and
separated by vertical bars; read the example as this or that. One or the other is
required.

[this | that] Optional items in syntax descriptions appear within brackets and separated by
vertical bars; read the example as an optional this or that.

[this, …] Optional item lists in syntax descriptions appear within brackets delimited by
commas and terminated with an ellipsis; read the example as an optional comma-
separated list of this.

.SECTION Commands, directives, keywords, and feature names are in text with letter
gothic font.

filename Non-keyword placeholders appear in text with letter gothic font and italic
style format.

NOTE:
 

NOTE: For correct operation, ..

A note provides supplementary information on a related topic. In the online ver-
sion of this book, the word NOTE: appears instead of this symbol.

Product Information
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Example Description

CAUTION:
 

CAUTION: Incorrect device operation may result if ..

CAUTION: Device damage may result if ..

A caution identifies conditions or inappropriate usage of the product that could
lead to undesirable results or product damage. In the online version of this book,
the word CAUTION: appears instead of this symbol.

ATTENTION:
 

ATTENTION: Injury to device users may result if ..

A warning identifies conditions or inappropriate usage of the product that could
lead to conditions that are potentially hazardous for devices users. In the online
version of this book, the word ATTENTION: appears instead of this symbol.

Notation Conventions
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2   Using the Board

This chapter provides information on the major components and peripherals on the board along with instrustions
for installing and setting up the emualtion software.

Product Overview
The board features:

• Analog Devices ADSP-CM419F processor

• 210 ball BGA

• 16 and 30 MHz oscillators

• Analog Interface

• Analog Devices Unity-Gain Stable, Ultralow Distortion, 1 nV/√Hz Voltage Noise, High Speed Op Amp
(ADA4899)

• Analog Devices Ultralow Noise, LDO XFET Voltage References with Current Sink and Source
(ADR441B)

• Analog Devices 1 ppm 20-Bit, ±1 LSB INL, Voltage Output DAC (AD5791)

• LCD

• 2.2 inch TFT LCD module

• SPI Flash (SPI0) chip

• Microchip 4K I2C Serial EEPROM (24AA04)

• Universal Asynchronous Receiver/Transmitter (UART0)

• Analog Devices Isolated Single Channel RS-232 Line Driver/Receiver (ADM3251E)

• DB9

• Universal Asynchronous Receiver/Transmitter (UART3)

• FTDI USB to UART (FT232R)

Using the Board
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• USB mini-B

• Universal Asynchronous Receiver/Transmitter (UART4)

• Analog Devices Isolated, Dual Channel RS-232 Line Driver/Receiver (ADM3252E)

• DB9

• CAN

• Analog Devices Signal and Power Isolated CAN Transceiver (ADM3053)

• RJ11

• SINC

• Analog Devices Isolated, 5 kV, DC-to-DC Converter (ADUM6000)

• Analog Devices Isolated Sigma-Delta Modulator (AD7401)

• Debug (JTAG/SWD/SWO) interface

• J-Link Lite emulator

• JTAG/SWD/SWO 20-pin 0.1” header

• JTAG/SWD/SWO 20-pin 0.05” header

• LEDs

• Five LEDs: one power (green), one board reset (red), two general-purpose (amber) and one fault (red)

• Pushbuttons

• Six pushbuttons: one reset and five IRQ/Flag

• Analog connector

• ADC

• AGND/GND/VREF/5V

• PWM connector

• PWM0-2

• SINC0

• SPI1

• SPORT0

• TWI0

• TMR0

• GPIOs

Product Overview
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• CNT0-3

• RESET
• GND/3.3V/5V output

• External power supply

• CE compliant

• 5V @3.6 Amps

• Power measurement

• 0.051-ohm resistors for measuring current draw

Package Contents
Your ADSP-CM419F EZ-KIT ® package contains the following items.

• ADSP-CM419F EZ-KIT ® board

• Universal 5V DC power supply

• USB 2.0 type A to mini-B cable

• J-Link Lite emulator

Contact the vendor where you purchased your EZ-KIT or contact Analog Devices, Inc. if any item is missing.

Default Configuration
The ADSP-CM419F EZ-KIT ® board is designed to run as a standalone unit.

The Default Hardware Setup figure shows the default settings for jumpers and switches and the location of the
jumpers, switches, connectors, and LEDs. Confirm that your board is in the default configuration before using the
board.

Package Contents
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Figure 2-1: Default Hardware Setup

IAR Embedded WorkBench Setup
For information about the IAR Embedded Workbench®and Segger® product and software download, go to:

http://www.iar.com/en/Products/IAR-Embedded-Workbench.

The ADSP-CM419F EZ-KIT ® software, based on the IAR Embedded WorkBench, can be found at:

http://www.analog.com/ADSPCM419FEZKIT

Follow these instructions to ensure correct operation of the product software and hardware.

IAR Embedded WorkBench Setup
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1. Connect the EZ-KIT board to a personal computer (PC) running IAR Embedded WorkBench, using a J-
Link/J-Trace emulator:

a. Plug one side of the USB cable into the USB connector of the emulator. Plug the other side into a USB
port of the PC running IAR Embedded WorkBench.

b. Attach the emulator to the header connector, P1 or P2 , on the EZ-KIT board.

2. Attach the provided cord and appropriate plug to the 5V power adapter:

a. Plug the jack-end of the power adapter into the power connector P19 on the EZ-KIT board.

b. Plug the other side of the power adapter into a power outlet. The power LED ( LED1 ) is lit green when
power is applied to the board.

It is assumed that the IAR Embedded WorkBench software is installed and running on your PC.

1. Navigate to the IAR Embedded WorkBench environment via the Start menu.

2. Choose File > Open > Workspace to open a workspace for the project to download and debug.

3. Choose Project > Options.

The General Options, Target page appears.

4. In Processor variant, ensure Device is Analog Devices CM41x

5. Choose Debugger in the Category pane.

The Debugger, Setup options page appears.

a. In Driver, choose J-Link/J-Trace as the emulator to be used to debug the target board.

b. Click the Download tab. The Debugger, Download options page appears.

c. Ensure Use flash loader(s) is enabled. Note that other download settings are optional.

6. Choose Debugger > J-Link/J-Trace in the Category pane.

The emulator Setup options page appears.

a. On the Setup page,

• In Reset, select Connect during reset from the drop-down list.

• In JTAG/SWD speed, select Auto.

• (Optional) In Clock setup, change the default values.

b. On the Connection page,

• In Communication, select USB and Device 0.

• In Interface, select SWD.

7. Click OK to save the emulator settings.

IAR Embedded WorkBench Setup
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8. Choose Project > Debug and Download to download the project and start debugging.

Debug Interface
The EZ-KIT provides a JTAG/SWD/SWO connection via .

Power-On-Self Test
The Power-On-Self-Test Program (POST) tests all EZ-KIT peripherals and validates functionality as well as connec-
tivity to the processor. Once assembled, each EZ-KIT is fully tested for an extended period of time with POST. All
EZ-KITs boards are shipped with POST preloaded into flash memory. The POST is executed by resetting the board
and pressing the proper push button(s). The POST also can be used as a reference for a custom software design or
hardware troubleshooting.

Note that the source code for the POST program is included in the Board Support Package (BSP) along with the
readme.txt file that describes how the board is configured to run POST.

Analog Input Channel Selection

The ADSP-CM419F EZ-KIT ® has 24 Primary ADC Input Channels & 7 Secondary ADC Input Channels as fol-
lows:

• Primary

• A0 - A7

• B0 - B7

• C0 - C7

• Secondary

• D0 - D7

Multiple input options are available for the ADC Inputs. These include:

• Expansion Interface

• On-board precision DAC

• Op-amp based conditionint of signals via SMC connector

There are 6 SMC connectors on board (J10, J11, J12, J13, J15, J16) that connects to the signal conditioning cir-
cuits (DUTs). Each Input can select between two such DUTs.

The inputs can also select between expansion interface or the DAC output. Note that DAC output is not available
on all channels. By default, all inputs (except A0) are connected to the expansion interface via resistors that need to
be installed. The input channel A0 is provided with jumpers on all four selections.

Debug Interface
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Power Architecture

Digital Supply

The ADSP-CM419F EZ-KIT ® has two primary voltage domains: 3.3V and 1.2V. The main input is a 5V wall
adaptor. The 5V source can be selected via JP44 to input from the PWM connector (J4) as an alternative to the
wall power adaptor. Refer to J4 and JP44 for details. The Analog Devices ADM7172 LDO provides 3.3V for the
VDD_EXT signal and the 3.3V power requirements of the board. The VDD_INT signal is delivered through either
Analog Devices regulator ADP1715 Linear Regulator (VR2) or a PNP transistor (Q1). Jumper JP2 is provided to
select between External and Internal regulator.

Analog Front End

The Analog Front End is powered via VDD_ANA0 and VDD_ANA1 power pins which fall in 3.3V domain. The
Fast Over Current Protection (FOCP) Comparators are powered via VDD_COMP. By default, analog supplies are
powered from the ADM7172 LDO which powers up the VDD_EXT and rest of the 3.3V domain. External sup-
plies can power up the analog domain via P6, P7 & P8. A +/-5V supply (via P11) is required for the Op Amps at
the input of the Analog Input Channels. A +/-15V supply is required for the DAC AD5791.

Power Measurements
Locations are provided for measuring the current draw from various power planes. Precision 0.051 ohm shunt resis-
tors are available on the 3.3V and VDD_EXT voltage domains. For current draw, the jumper is removed, voltage
across the resistor can be measured using an oscilloscope, and the value of the resistor can be measured using a preci-
sion multi-meter. Once voltage and resistance are measured, the current can be calculated by dividing the voltage by
the resistance. For the highest accuracy, a differential probe should be used for measuring the voltage across the resis-
tor.

Example Programs
Example programs are provided with the ADSP-CM419F EZ-KIT ® Board Support Package (BSP) to demonstrate
various capabilities of the product. The programs can be found in the ADSP-CM419F_EZ-KIT\examples installa-
tion folder. Refer to a readme file provided with each example for more information.

Reference Design Information
A reference design info package is available for download on the Analog Devices Web site. The package provides
information on the schematic design, layout, fabrication, and assembly of the board.

The information can be found at:

http://www.analog.com/ADSPCM419FEZKIT .

Power Architecture
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32M-bit Serial Flash Memory with Dual and Quad SPI
(W25Q32)
The W25Q32BV (32 Mb) Serial Flash memory provides a storage solution for systems with limited space, pins and
power. The 25Q series offers flexibility and performance well beyond ordinary Serial Flash devices. They are ideal
for code shadowing to RAM, executing code directly from Dual/Quad SPI (XIP) and storing voice, text and data.
The device operates on a single 2.7V to 3.6V power supply with current consumption as low as 4 mA active and 1
uA for power-down.

The W25Q32BV array is organized into 16,384 programmable pages of 256 bytes each. Up to 256 bytes can be
programmed at a time. Pages can be erased in a group of 16 (4 KB sector erase), groups of 128 (32 KB block erase),
groups of 256 (64 KB block erase) or the entire chip (chip erase). The W25Q32BV has 1024 erasable sectors and 64
erase blocks respectively. The small 4 KB sectors allow for greater flexibility in applications that require data and
parameter storage.

The W25Q32BV supports the standard Serial Peripheral Interface (SPI), and a high performance Dual/Quad ouput
as well as Dual/Quad I/O SPI: Serial Clock, Chip Select, Serial Data I/O0 (DI), I/O1 (DO), I/O2 (WP), and I/O3
(/HOLD). SPI clock frequencies of up to 104 MHz are supported, providing equivalent clock rates of 208 MHz
(104 MHz x 2) for Dual I/O and 320 MHz (80 MHz x 4) for Quad I/O when using Fast Read Dual/Quad I/O
instructions. These transfer rates can outperform standard Asynchronous 8 and 16-bit Parallel Flash memories. The
Continous Read Mode allows for efficient memory access with as few as 8-clocks of instruction-overhead to read a
24-bit address, allowing true XIP (execute in place) operation.

USB to UART (FT232R)
The FT232R is a USB-to-serial-UART interface with the following advanced features:

• Single chip USB to asynchronous serial data transfer interface

• Entire USB protocol handled on the chip. No USB specific firmware programming required

• Fully-integrated 1024 bit EEPROM storing device descriptors and CBUS I/O configuration

• Fully-integrated USB termination resistors

• Fully-integrated clock generation with no external crystal required, plus optional clock output selection ena-
bling a glue-less interface to external MCU or FPGA

• Data transfer rates from 300 baud to 3 Mbaud (RS422, RS485, RS232) at TTL levels

• 128 byte receive buffer and 256 byte transmit buffer utilising buffer smoothing technology to allow for high-
data throughput

• FTDI’s royalty-free Virtual Com Port (VCP) and Direct (D2XX) drivers eliminate the requirement for USB
driver development in most cases.

• Transmit and receive LED drive signals

32M-bit Serial Flash Memory with Dual and Quad SPI (W25Q32)
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• UART interface support for 7 or 8 data bits, 1 or 2 stop bits and odd / even / mark / space / no parity

• FIFO receives and transmits buffers for high-data throughput

• Device supplied pre-programmed with unique USB serial number

• Supports bus powered, self-powered and high-power bus powered USB configurations

• Integrated +3.3V level converter for USB I/O

• Integrated level converter on UART and CBUS for interfacing to between +1.8V and +5V logic

• True 5V/3.3V/2.8V/1.8V CMOS drive output and TTL input

• Configurable I/O pin output drive strength

• Integrated power-on-reset circuit

• Fully-integrated AVCC supply filtering - no external filtering required.

• UART signal inversion option

• +3.3V (using external oscillator) to +5.25V (internal oscillator) single supply operation

• Low-operating and USB suspend current

• Low USB bandwidth consumption

• UHCI/OHCI/EHCI host controller compatible

• USB 2.0 full speed compatible

Signal and Power Isolated CAN Transceiver (ADM3053)

The ADM3053 is an isolated controller area network (CAN) physical layer transceiver with an integrated isolated
dc-to-dc converter. The ADM3053 complies with the ISO 11898 standard.

The device employs Analog Devices, Inc., iCoupler® technology to combine a 2-channel isolator, a CAN transceiv-
er, and Analog Devices isoPower® dc-to-dc converter into a single SOIC surface mount package. An on-chip oscil-
lator outputs a pair of square waveforms that drive an internal transformer to provide isolated power. The device is
powered by a single 5 V supply realizing a fully isolated CAN solution.

The ADM3053 creates a fully isolated interface between the CAN protocol controller and the physical layer bus. It
is capable of running at data rates of up to 1 Mbps.

The device has current limiting and thermal shutdown features to protect against output short circuits. The part is
fully specified over the industrial temperature range and is available in a 20-lead, wide-body SOIC package.

The ADM3053 contains isoPower technology that uses high frequency switching elements to transfer power
through the transformer. Special care must be taken during printed circuit board (PCB) layout to meet emissions
standards. Refer to the AN-0971 Application Note, Control of Radiated Emissions with isoPower Devices, for de-
tails on board layout considerations.

Signal and Power Isolated CAN Transceiver (ADM3053)
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Isolated Single Channel RS-232 Line Driver/Receiver
(ADM3251E)

The ADM3251E1 is a high speed, 2.5 kV fully isolated, single-channel RS-232/V.28 transceiver device that operates
from a single 5 V power supply. Due to the high ESD protection on the RIN and TOUT pins, the device is ideally
suited for operation in electrically harsh environments or where RS-232 cables are frequently being plugged and un-
plugged.

The ADM3251E incorporates dual-channel digital isolators with isoPower™ integrated, isolated power. There is no
requirement to use a separate isolated dc-to-dc converter. Chip-scale trans-former iCoupler® technology from Ana-
log Devices, Inc., is used both for the isolation of the logic signals as well as for the inte-grated dc-to-dc converter.
The result is a total isolation solution.

The ADM3251E contains isoPower technology that uses high frequency switching elements to transfer power
through the transformer. Special care must be taken during printed circuit board (PCB) layout to meet emissions
standards. Refer to Application Note AN-0971, Control of Radiated Emissions with isoPower Devices, for details on
board layout considerations.

The ADM3251E conforms to the EIA/TIA-232E and ITU-T V. 28 specifications and operates at data rates up to
460 kbps.

Four external 0.1 μF charge pump capacitors are used for the voltage doubler/inverter, permitting operation from a
single 5 V supply.

The ADM3251E is available in a 20-lead, wide body SOIC package and is specified over the −40°C to +85°C tem-
perature range.

Isolated, Dual Channel RS-232 Line Driver/Receiver
(ADM3252E)

The ADM3252E is a high speed, 2.5 kV, fully isolated, dual- channel RS-232/V.28 transceiver device that is opera-
tional from a single 3.3 V or 5 V power supply. Because of high ESD protection on the RIN1, RIN2, TOUT1, and
TOUT2 pins, the ADM3252E is ideally suited for operation in electrically harsh environments or where RS-232
cables are frequently plugged and unplugged.

The ADM3252E provides four independent isolation channels using the integrated and isolated power of isoPow-
er™. There is no requirement to use a separate isolated dc-to-dc converter. Chip scale transformer iCoupler® tech-
nology from Analog Devices, Inc., is used for both the isolation of the logic signals and the integrated dc-to-dc con-
verter. The result is a total isolation solution.

isoPower technology in the ADM3252E uses high frequency switching elements to transfer power through its trans-
former. Special care must be taken during printed circuit board (PCB) layout to meet emissions standards. Refer to
the AN-0971 Application Note, Recommendations for Control of Radiated Emissions with isoPower Devices, for
details on board layout considerations.

Isolated Single Channel RS-232 Line Driver/Receiver (ADM3251E)
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The ADM3252E conforms to the EIA/TIA-232E and ITU-T V.28 specifications and operates at data rates of up to
460 kbps. Four external 0.1 μF charge pump capacitors are used for the voltage doubler/inverter, permitting opera-
tion from a single 3.3 V or 5 V supply. The ADM3252E is available in a 44-ball, chip scale package ball grid array
(CSP_BGA) and is specified over the −40°C to +85°C temperature range.

Unity-Gain Stable, Ultralow Distortion, 1 nV/√Hz Voltage Noise,
High Speed Op Amp (ADA4899)

The ADA4899-1 is an ultralow noise (1 nV/√Hz) and distortion (<−117 dBc @1 MHz) unity-gain stable voltage
feedback op amp, the combination of which makes it ideal for 16-bit and 18-bit systems. The ADA4899-1 features
a linear, low noise input stage and internal compensation that achieves high slew rates and low noise even at unity
gain. The Analog Devices, Inc. proprietary next-generation XFCB process and innovative circuit design enable such
high performance amplifiers.

The ADA4899-1 drives 100 Ω loads at breakthrough performance levels with only 15 mA of supply current. With
the wide supply voltage range (4.5 V to 12 V), low offset voltage (230 μV maximum), wide bandwidth (600 MHz),
and slew rate (310 V/μs), the ADA4899-1 is designed to work in the most demanding applications. The
ADA4899-1 also features an input bias current cancellation mode that reduces input bias current by a factor of 60.

The ADA4899-1 is available in a 3 mm × 3 mm LFCSP and an 8-lead SOIC package. Both packages feature an
exposed metal paddle that improves heat transfer to the ground plane, which is a significant improvement over tradi-
tional plastic packages. The ADA4899-1 is rated to work over the extended industrial temperature range, −40°C to
+125°C.

Ultralow Noise, LDO XFET Voltage References with Current Sink
and Source (ADR441B)

The ADR44x series is a family of XFET® voltage references featuring ultralow noise, high accuracy, and low tem-
perature drift performance. Using Analog Devices, Inc., patented temperature drift curvature correction and XFET
(eXtra implanted junction FET) technology, voltage change vs. temperature nonlinearity in the ADR44x is greatly
minimized.

The XFET references offer better noise performance than buried Zener references, and XFET references operate off
low supply voltage headroom (0.5 V). This combination of features makes the ADR44x family ideally suited for
precision signal conversion applications in high-end data acquisition systems, optical networks, and medical applica-
tions.

The ADR44x family has the capability to source up to 10 mA of output current and sink up to −5 mA. It also
comes with a trim terminal to adjust the output voltage over a 0.5% range without compromising performance.

Offered in two electrical grades, the ADR44x family is avail-able in 8-lead MSOP and narrow SOIC packages. All
versions are specified over the extended industrial temperature range of −40°C to +125°C.

Unity-Gain Stable, Ultralow Distortion, 1 nV/√Hz Voltage Noise, High Speed Op Amp (ADA4899)
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36 V Precision, 2.8 nV/√Hz Rail-to-Rail Output Op Amp
(AD8675)

The AD8675 precision operational amplifier has ultralow offset, drift, and voltage noise combined with very low
input bias currents over the full operating temperature range. The AD8675 is a precision, wide bandwidth op amp
featuring rail-to-rail output swings and very low noise. Operation is fully specified from ±5 V to ±15 V.

The AD8675 features a rail-to-rail output like that of the OP184, but with wide bandwidth and even lower voltage
noise, combined with the precision and low power consumption like that of the industry-standard OP07 amplifier.
Unlike other low noise, rail-to-rail op amps, the AD8675 has very low input bias current and low input current
noise.

With typical offset voltage of only 10 μV, offset drift of 0.2 μV/°C, and noise of only 0.10 μV p-p (0.1 Hz to 10
Hz), the AD8675 is perfectly suited for applications where large error sources cannot be tolerated. For applications
with even lower offset tolerances, the proprietary nulling capability allows a combination of both device and system
offset errors up to 3.5 mV (referred to the input) to be compensated externally. Unlike previous circuits, the
AD8675 accommodates this adjustment without adversely affecting the offset drift, CMRR, and PSRR of the am-
plifier. Precision instrumentation, PLL, and other precision filter circuits, position and pressure sensors, medical in-
strumentation, and strain gage amplifiers benefit greatly from the very low noise, low input bias current, and wide
bandwidth. Many systems can take advantage of the low noise, dc precision, and rail-to-rail output swing provided
by the AD8675 to maximize SNR and dynamic range.

The smaller packages and low power consumption afforded by the AD8675 allow maximum channel density or
minimum board size for space-critical equipment.

The AD8675 is specified for the extended industrial temperature range (−40°C to +125°C). The AD8675 amplifier
is available in the tiny 8-lead MSOP, and the popular 8-lead, narrow SOIC, RoHS compliant packages. MSOP
packaged devices are only available in tape and reel format.

Ultraprecision, 36 V, 2.8 nV/√Hz Dual Rail-to-Rail Output Op
Amp (AD8676)

The AD8676 precision operational amplifier offers ultralow offset, drift, and voltage noise combined with very low
input bias currents over the full operating temperature range. The AD8676 is a precision, wide bandwidth op amp
featuring rail- to-rail output swings and very low noise. Operation is fully specified from ±5 V to ±15 V.

The AD8676 features a rail-to-rail output like that of the OP184, but with wide bandwidth and even lower voltage
noise, com-bined with the precision and low power consumption like that of the industry-standard OP07 amplifier.
Unlike other low noise, rail-to-rail op amps, the AD8676 has very low input bias current and low input current
noise.

With typical offset voltage of only 12 μV, offset drift of 0.2 μV/°C, and noise of only 0.10 μV p-p (0.1 Hz to 10
Hz), the AD8676 is perfectly suited for applications where large error sources cannot be tolerated. Precision instru-
mentation, PLL and other precision filter circuits, position and pressure sensors, medical instrumentation, and strain

36 V Precision, 2.8 nV/√Hz Rail-to-Rail Output Op Amp (AD8675)
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gage amplifiers benefit greatly from the very low noise, low input bias current, and wide bandwidth. Many systems
can take advantage of the low noise, dc precision, and rail-to-rail output swing provided by the AD8676 to maxi-
mize SNR and dynamic range.

The smaller packages and low power consumption afforded by the AD8676 allow maximum channel density or
minimum board size for space-critical equipment.

The AD8676 is specified for the extended industrial temperature range (−40°C to +125°C). The AD8676 is availa-
ble in the 8-lead MSOP, and the popular 8-lead, narrow SOIC; both of which are lead-free packages. MSOP pack-
aged devices are only available in tape and reel format.

1 ppm 20-Bit, ±1 LSB INL, Voltage Output DAC (AD5791)

The AD57911 is a single 20-bit, unbuffered voltage-output DAC that operates from a bipolar supply of up to 33 V.
The AD5791 accepts a positive reference input in the range 5 V to VDD − 2.5 V and a negative reference input in
the range VSS + 2.5 V to 0 V. The AD5791 offers a relative accuracy specification of ±1 LSB max, and operation is
guaranteed monotonic with a ±1 LSB DNL maximum specification.

The part uses a versatile 3-wire serial interface that operates at clock rates up to 35 MHz and that is compatible with
standard SPI, QSPI™, MICROWIRE™, and DSP interface standards. The part incorporates a power-on reset cir-
cuit that ensures the DAC output powers up to 0 V and in a known output impedance state and remains in this
state until a valid write to the device takes place. The part provides an output clamp feature that places the output in
a defined load state.

Isolated, 5 kV, DC-to-DC Converter (ADUM6000)

The ADuM60001 is an isolated dc-to-dc converter based on the Analog Devices, Inc., iCoupler® technology. The
dc-to-dc converter in this device provides regulated, isolated power in several combi- nations of input and output
voltages.

The Analog Devices chip scale transformer iCoupler technology transfers isolated power in this dc-to-dc converter
with up to 31% efficiency. The result is a small form factor, total isolation solution.

Higher output power levels are obtained by using the ADuM6000 to augment the power output of the ADuM5401,
ADuM5402, ADuM5403, ADuM5404, ADuM520x, and ADuM620x iCouplers with isoPower®.

isoPower uses high frequency switching elements to transfer power through its transformer. Special care must be tak-
en during printed circuit board (PCB) layout to meet emissions standards. See the AN-0971 Application Note for
board layout recommendations.

Isolated Sigma-Delta Modulator (AD7401)

The AD74011 is a second-order, sigma-delta (Σ-Δ) modulator that converts an analog input signal into a high
speed, 1-bit data stream with on-chip digital isolation based on Analog Devices, Inc., iCoupler® technology. The

1 ppm 20-Bit, ±1 LSB INL, Voltage Output DAC (AD5791)
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AD7401 operates from a 5 V power supply and accepts a differential input signal of ±200 mV (±320 mV full scale).
The analog input is continuously sampled by the analog modulator, eliminating the need for external sample- and-
hold circuitry. The input information is contained in the output stream as a density of ones with a data rate up to 20
MHz. The original information can be reconstructed with an appropriate digital filter. The serial input/output can
use a 5 V or a 3 V supply (VDD2).

The serial interface is digitally isolated. High speed CMOS, combined with monolithic air core transformer technol-
ogy, means the on-chip isolation provides outstanding performance characteristics, superior to alternatives such as
optocoupler devices. The device contains an on-chip reference. The AD7401 is offered in a 16-lead SOIC and has
an operating temperature range of −40°C to +105°C.

4K I2C Serial EEPROM (24AA04)

The Microchip Technology Inc. 24AA04/24LC04B (24XX04*) is a 4 Kbit Electrically Erasable PROM. The device
is organized as two blocks of 256 x 8-bit memory with a 2-wire serial interface. Low-voltage design permits opera-
tion down to 1.7V, with standby and active currents of only 1 μA and 1 mA, respectively. The 24XX04 also has a
page write capability for up to 16 bytes of data.

2.2 TFT LCD

This 2.2-inch TFT LCD module features a SPI interface fully compatible with popular LCD5110 interface.

Features

• TFT01_2.2 SP is a 2.2 "SPI TFT LCD Screen Module, 10pins interface, compatible LCD5110 interface. Not
just a LCD but also includes an SD card connector.

• The LCD in the TFT01 is ILI9341. It's a 240 * 320 (resolution), 2.2S inch TFT LCD screen.The LCD has a
wide viewing angle, the contrast is also very suitable.

• The display interface is serial, it just needs 5 wires (CS, RS, SCL, SDA, RST) for controlling.

• SDcard use hardware SPI interface (CS / MOSI / MISO / SCK).

4K I2C Serial EEPROM (24AA04)

2–14 ADSP-CM419F EZ-KIT ® Manual



3   Hardware Reference

This chapter describes the hardware design of the ADSP-CM419F EZ-KIT ® .

System Architecture
The board's configuration is shown in the Block Diagram figure.
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Figure 3-1: Block Diagram

This EZ-KIT is designed to demonstrate the ADSP-CM419F processor’s capabilities. The board has a 30 MHz
input clock and runs at 240 MHz internally.

User I/O to the processor is provided in the form of five pushbuttons and three LEDs.

Hardware Reference
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Switches
This section describes operation of the switches. The switch locations are shown in the Switch Locations figure.

SW7

SW9

SW8

SW6

SW4

SW1SW5 SW3

SW2

Figure 3-2: Switch Locations

Reset Pushbutton ( SW6 )

The reset pushbutton resets the ADSP-CM419F processor. The reset signal also is connected to the expansion con-
nectors via the SYS_HWRST signal. Reset ( LED4 ) is used to indicate when the board is in reset.

Switches
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GPIO Pushbuttons ( SW1-5 )

The GPIO pushbuttons are connected to the processor’s signals PF_08/SPI1_SEL7/LBA_PIN5/SYS_DSWAKE2,
PA_00/SPI0_SEL2/TM0_CLK/SPI0_SS, PA_01/SPI0_SEL3/SPI0_RDY/TM0_ACI2, PE_14/TM1_TMR0/
SMC0_A05 and PE_15/TM1_TMR1/SMC0_A10, respectively. Each individual pushbutton is connected/disconnect-
ed from the processor by Pushbutton Enable ( SW7 )

Wake Push Button PB1 is connected to one of the Wake Up signals of the DPM Deep Sleep mode of operation. A
Monostable Pulse Generator (One Shot) IC is provided for the wake-up signal

Pushbutton Enable ( SW7 )

The Pushbutton enable switch is used to connect/disconnect the pushbuttons from the processor. When the switch
is in the ON position the respective pushbutton is connected to the processor. When the switch is in the OFF posi-
tion the respective pushbutton is disconnected from the processor and the signal can be used for another function.
The Pushbutton Enable Switch table shows the available settings. By default, all positions of the switch are ON.

Table 3-1:    Pushbutton Enable Switch

Position Pushbutton Processor Signal

1 SW1 PF_08/SPI1_SEL7/LBA_PIN5/SYS_DSWAKE2

2 SW2 PA_00/SPI0_SEL2/TM0_CLK/SPI0_SS

3 SW3 PA_01/SPI0_SEL3/SPI0_RDY/TM0_ACI2

4 SW4 PE_14/TM1_TMR0/SMC0_A05

5 SW5 PE_15/TM1_TMR1/SMC0_A10

6 NA Not Used

SPI Flash Enable ( SW8 )

The SPI flash enable switch is used to connect/disconnect the SPI Flash from the processor. When the switch is in
the ON position the respective signal is connected between the SPI flash and the processor. When the switch is in
the OFF position the respective signal is disconnected between the SPI flash and the processor and the signal can be
used for another function. The SPI Flash Enable Switch table shows the available settings. By default, all positions
of the switch are ON.

Table 3-2:    SPI Flash Enable Switch

Position Processor Signal

1 PA_09/SPI0_MOSI/TM0_ACLK0

2 PA_08/SPI0_CLK/TM0_ACLK3

3 PA_11/SPI0_SEL1/SYS_DSWAKE3

4 PA_02/SPI0_D2/UART0_RTS/SPI0_SEL6/TM0_ACI3

Switches
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Table 3-2:    SPI Flash Enable Switch (Continued)

Position Processor Signal

5 PA_03/SPI0_D3/UART0_CTS/SPI0_SEL7/TM0_ACI4

6 PA_10/SPI0_MISO/TM0_ACLK1

LED Enable ( SW9 )

The LED enable switch is used to connect/disconnect the LEDs from the processor. When the switch is in the ON
position the respective signal is connected between the LED and the processor. When the switch is in the OFF posi-
tion the respective signal is disconnected between the LED and the processor and the signal can be used for another
function. The LED Enable Switch table shows the available settings. By default, all positions of the switch are ON.

Table 3-3:    LED Enable Switch

Position LED Processor Signal

1 LED2 PA_13/TM0_TMR1

2 LED3 PF_02/SPI1_SEL4/SMC0_A08

Jumpers
This section describes functionality of the configuration jumpers. The Jumper Locations figure shows the jumper
locations.

Switches
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Figure 3-3: Jumper Locations

Boot Mode Select ( JP1 )

The Boot Mode selection jumper selects between the two boot modes of the processor. When a jumper is not instal-
led (default), the BMODE will be 0 which corresponds to direct code execution from flash up on a reset. When a
jumper is installed, the BMODE will be 1 which corresponds to boot from UART. The pushbutton switch deter-
mines the boot mode of the processor. The Boot Mode Jumper table shows the available boot mode settings. By
default, the processor boots from the internal flash memory.

Jumpers
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Table 3-4:    Boot Mode Jumper

Position Processor Boot Mode

installed UART download mode

not installed Flash boot. Boot from integrated flash memory.

VDD_INT Regulator Select ( JP2 )

The VDD_INT regulator select jumper selects whether an internal or external voltage regulator supplies the
VDD_INT power to the processor. When a jumper is installed between pins 1 & 2 (default), the internal voltage
regulator supplies VDD_INT. When a jumper is installed between pins 2 & 3, the the external voltage regulator
supplies VDD_INT. The VDD_INT Regualtor Select Jumper table shows the available modes for supplying power
to VDD_INT. By default, VDD_INT is supplied by the internal regulator.

Table 3-5:    VDD_INT Regulator Select Jumper

Position VDD_INT Source

1 and 2 Internal regulator

2 and 3 External regulator

CAN Interface ( JP4 and JP5 )

The CAN interface jumpers are used to connect/disconnect the CAN transmit and receive signals from the process-
or to the ADM3053. When the jumpers are installed on pins 1 - 2 and pins 3 - 4 the CAN data signals are connec-
ted between the processor and ADM3053. When the jumpers are not installed the signals are not connected and
may be used for other functions on the board. The default setting is that all jumpers are installed.

Table 3-6:    CAN Interface Jumper (JP4)

Position Processor Signal

1 and 2 PA_07/CAN0_TX/SPI0_SEL5/TM0_ACLK2

3 and 4 PA_06/CAN0_RX/SPI0_SEL4/TM0_ACI1

Table 3-7:    CAN Interface Jumper (JP5)

Position Processor Signal

1 and 2 PE_13/CAN1_TX/SMC0_ABE0

3 and 4 PE_12/CAN1_RX/SMC0_ABE1/TM1_ACI0

UART Interface( JP6 and JP7 )

The UART interface jumper (JP6) is used to used to connect/disconnect the UART4 signals (transmit, receive and
flow control) with the RS-232 transciever IC ADM3252E and RS-232 connector. When the jumpers are not

Jumpers
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installed the signals are not connected and may be used for other functions on the board. By default, jumpers 1-2,
3-4, 5-6 and 7-8 are installed; they must be populated to run the UART boot mode.

The RS-232 interface jumper (JP7) is used to used to connect/disconnect the UART0 signals (transmit and receive)
with the RS-232 transciever IC ADM3252E and RS-232 connector. When the jumpers are not installed the signals
are not connected and may be used for other functions on the board. By default, jumpers 1-2 and 3-4 are installed.
Hardware Flow Control is not supported for this interface.

The UART Interface Jumper table shows the available settings. By default, all positions of the switch are ON.

Table 3-8:    UART Interface Jumper (JP6)

Position Processor Signal

1 and 2 PF_04/UART4_TX/SMC0_A13/LBA_PIN1

3 and 4 PE_01/PWM2_AL/UART4_RTS/SMC0_AMS1

5 and 6 PF_05/UART4_RX/SPI1_SEL5/LBA_PIN2/TM1_ACI6

7 and 8 PE_03/PWM2_BL/UART4_CTS/SMC0_A15

Table 3-9:    UART Interface Jumper (JP7)

Position Processor Signal

1 and 2 PA_05/UART0_TX/TM0_ACLK4

3 and 4 PA_04/UART0_RX/TM0_ACI0

VREF Source ( JP8 - JP10 )

The VREF source jumpers select whether an internal or external voltage reference supplies the VREF0, VREF1 and
VREF2 signal of the processor. When a jumper is not installed (default), the internal voltage reference supplies
VREF0, VREF1 and VREF2. When a jumper on is installed, the external Analog Devices ADR441 ultra-low noise
voltage reference supplies VREF0, VREF1 and VREF2.

ADC VIN0 A0 ( JP11 - JP14 )

The ADC VIN0 A0 jumper selects the source of the VIN0_A0 signal on the processor. Only one jumper should be
installed at a time.

The ADC VIN0 A0 Jumper table shows the available settings. By default, JP13 is installed.

Table 3-10:    ADC VIN0 A0

Jumper Reference Signal

JP11 ADC_VIN_A0_EXP

JP12 AIN_DUT1

JP13 AIN_DUT0

Jumpers
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Table 3-10:    ADC VIN0 A0 (Continued)

Jumper Reference Signal

JP14 DAC_TEST_SOURCE

AIN DUT ( JP15 - JP37 )

Are we keeping these jumpers???????

DC Bias Source( JP38 and JP39 )

The DC bias source jumper is used for configuring the bias used for the signal conditioning circuitry.

When a jumper is installed on pins 1 and 2 of JP38 a precision voltage reference(ADR443) of 0.75 is enabled.
When a jumper is installed on pins 2 and 3 an external reference voltage should be applied to DC Bias ( J17 ). By
default a jumper is installed on pins 1 and 2.

When a jumper is installed on pins 1 and 2 of JP39 the unity gain buffer is bypassed. When a jumper is installed on
pins 2 and 3 the precision voltage reference output configured on JP38 is conencted to the unity gain buffer input.
By default a jumper is installed on pins 2 and 3.

This jumper is used in conjunction with DC Bias Select ( P5 )

SINC Interface( JP40 )

The SINC interface jumper is used to connect/disconenct the SINC data and clock signals between the processor
and the AD7401. When the jumpers are not installed the signals are not connected and may be used for other func-
tions on the board.

The SINC Interface Jumper table shows the available settings. By default, jumpers 1-2 and 3-4 are installed.

Table 3-11:    SINC Interface Jumper

Position Processor Signal

1 and 2 PF_00/SINC0_D2/SMC0_A06

3 and 4 PC_15/SINC0_CLK0/UART1_RTS/SPT0_ATDV/TM1_ACLK3

Main Power Select ( JP44 )

The main power select jumper selects whether the main power source for the board is provided from the wall trans-
former or an optional 5V external source. Refer to the Main Power Select Jumper table. The default setting is to
power the board from the wall power adapter.

Jumpers
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Table 3-12:    Main Power Select Jumper

Position Power Source

1 and 2 Wall 5V

2 and 3 5V Input

DC Bias Select ( P5 )

The DC bias jumper provides DC BIAS for all the required signal conditioning circuitry. This jumper is used in
conjunction with DC Bias Source( JP38 and JP39 )

The DC Bias Select Jumper table shows the available settings. By default, positions 3-4 are populated.

Table 3-13:    DC Bias Select Jumper

Position Bias Signal

1 and 2 DC_BIAS0

3 and 4 DC_BIAS1

5 and 6 DC_BIAS2

7 and 8 DC_BIAS3

9 and 10 DC_BIAS4

11 and 12 DC_BIAS5

Isolated Power ( P15 )

The isolated Power jumper connects the isolated 5V supply from ADUM6000 to the SIGMA DELTA ADC
AD7401. By default this jumper is installed.

Single Ended Input ( P16 )

The single ended input jumper is used to provide a single ended input to the sigma delta converter. By default this
jumper is not installed.

AD7401 Power ( P17 )

When the AD7401 power jumper is installed the 3.3V supply is conencted to the Modulator AD7401 for its serial
I/O pins. By default this jumper is installed.

Current Measurement ( P20 and P21 )

The current measurement jumpers are used to measure the current draw of the VDD_EXT of the processor and 3V
IO power rail. The default is for both jumpers to be installed. To measure the current draw of the VDD_EXT of the

Jumpers
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processor, remove the jumper on P20 and measure the voltage across the precision resistor. The current can be cal-
culated by dividing the measured voltage by the 0.051 ohm resistor. In order to measure the current draw on the 3V
IO rail remove the jumper on P21 and measure the voltage across the precision resistor. The current can be calcula-
ted by dividing the measured voltage by the 0.051 ohm resistor.

LEDs
This section describes the on-board LEDs. The LED Locations figure shows the LED locations.

LED4

LED5

LED2

LED3LED1

Figure 3-4: LED Locations

Power ( LED1 )

When ON (green), it indicates that power is being supplied to the board properly.

LEDs
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GPIO ( LED2-3 )

Three LEDs are connected to the general-purpose I/O pins of the processor (see the GPIO LEDs table). The LEDs
are active high and are ON (amber) by writing a 1 to the correct processor signal.

Table 3-14:    GPIO LEDs

LED Reference Designator Processor Programmable Flag Pin

LED3 P0_13

LED4 P1_12

LED5 P1_13

Reset ( LED4 )

When ON (red), it indicates that the board is in reset. A master reset is asserted by pressing SW6 , which activates
the LED. For more information, see Reset Pushbutton ( SW6 ).

Fault ( LED5 )

When ON, it indicates a system fault. For more information, refer to the ADSP-CM41x Mixed-Signal Control Pro-
cessor Hardware Reference.

Connectors
This section describes connector functionality and provides information about mating connectors. The connector
locations are shown in the Connector Locations figure.

LEDs
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P19

P2

P1

P6

P7

P8

J1

J2

J4 J3

J16J13J11J5J14

P12

J15J12J10

P11

J17

J18

J7J6

J9J8

P3

J20

J19

J21

Figure 3-5: Connector Locations

NOTE: Connectors on the back of the board are noted with dotted lines.
 

Clock ( J1 and J2 )

The clock connectors allow for a connection point to the SYS_CLK1 and SYS_CLK2 signals on the processor.

Part Description Manufacturer Part Number

SMC 75 ohms Amphenol 152119-75

Connectors
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Part Description Manufacturer Part Number

Mating Cable

SMC cable

Analog Interface ( J3 )

One board-to-board connector provides signals to the ADC interfaces of the processor. This connector is located on
the bottom side of the board. The connector expands the board's capabilities by providing an interface to daughter-
boards.

Part Description Manufacturer Part Number

120-pin 0.5mm Samtec QSH-060-F-D_A

Mating Connector

120-pin 0.5mm Samtec QTH-060-01-F-D-A

PWM Interface ( J4 )

One board-to-board connector provides signals from the PWM, SINC, TWI, SPI, SPORT, and GPIO interfaces of
the processor. This connector is located on the bottom side of the board. The connector expands the board's capa-
bilities by providing an interface to daughterboards.

Part Description Manufacturer Part Number

180-pin 0.5mm Samtec QSH-090-F-D_A

Mating Connector

180-pin 0.5mm Samtec QTH-090-01-F-D-A

DAC0 VOUT( J5 )

The DAC0 VOUT connector provides a measurement point for the processor signal.

Part Description Manufacturer Part Number

SMC 75 ohms Amphenol 152119-75

Mating Cable

SMC cable

CAN ( J6 and J7 )

Connectors
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Part Description Manufacturer Part Number

RJ11 TE Connectivity 5558872-1

Mating Cable

RJ11 cable

UART ( J8 and J9 )

Part Description Manufacturer Part Number

DB9 Female Norcomp 191-009-213-L-571

Mating Cable

DB9 cable

ADC Input ( J10-J13, J15 and J16 )

The ADC input connectors provide a connection point for the input to the unity gain buffers.

Part Description Manufacturer Part Number

SMC 75 ohms Amphenol 152119-75

Mating Cable

SMC cable

DC Bias ( J17 )

The DC bias connector is used to provide an external connection point for supplying a DC bias to the unity gain
buffer by installing a jumper on pins 2 and 3 of JP38.

Part Description Manufacturer Part Number

SMC 75 ohms Amphenol 152119-75

Mating Cable

SMC cable

Sense ( J18 )

The sense connector provides a connection point for supplying a signal to the AD7401.

Part Description Manufacturer Part Number

SMC 75 ohms Amphenol 152119-75

Mating Cable

Connectors
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Part Description Manufacturer Part Number

SMC cable

LCD ( J19 and J20 )

Part Description Manufacturer Part Number

10x1 IDC Header.1" Samtec SSW-110-01-T-S

Mating Daughterboard

2.2" TFT LCD Adafruit 1480

Character Display ( J21 )

Part Description Manufacturer Part Number

5x2 IDC Header.1" Samtec SSW-105-22-F-D-VS

Mating Daughterboard

20x2 character display Newhaven Display NHD-0220D3Z-FL-GBW-V3

Debug ( P1 and P2 )

The debug connectors provides a connection point for the emualtor to interface with the processor. There are two
debug connectors on the board. The P4 connector is a 0.1” 20 pin connector. The P5 connector is a 0.05" 10 pin
connector. For more information, see Debug Interface.

USB ( P3 )

The USB connector provides an interface between the EZ-KIT and a host PC via the USB to UART (FT232R).

Part Description Manufacturer Part Number

USB mini-B Hirose UX60SC-MB-5S8

AFE Supply ( P6 - P9, P11 and P12 )

The AFE supply connectors provide a connection point to supply the analog power by an external power supply.

Part Description Manufacturer Part Number

2 pin terminal block header 3.81mm Phoenix 1803277

Mating Connector

2 pin terminal block plug 3.81mm Phoenix ?

Connectors
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Part Description Manufacturer Part Number

3 pin terminal block header 3.81mm Phoenix 1803280

Mating Connector

3 pin terminal block plug 3.81mm Phoenix ?

Power ( P19 )

The power connector provides power to the board when the jumper of Main Power Select ( JP44 ) is placed on pins
1 and 2.

Part Description Manufacturer Part Number

0.65 mm power jack CUI 045-0883R

Mating Connector

5.0VDC@3.6A power supplier GLOBETEK GS-1750(R)

Connectors
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